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5 Digitális fényképek 
korrekciója és 
tökéletesítése

Akár üzleti célra összeállított digitális képeinket, akár személyes fotóink gyűjteményét kíván-
juk finomítani, archiválni vagy megőrizni az utókor számára, a Photoshop számtalan esz-
közt kínál a digitális fényképek importálására, szerkesztésére és archiválására.
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A lecke áttekintése
Ebben a leckében a következőket fogjuk elsajátítani:

•	 Camera Raw kép feldolgozása és elmentése az iparági szabványnak megfelelő digitális negatívként
•	 Általános korrekciók végrehajtása a digitális fényképen, többek között vörös szem és zaj eltávolí-

tása, illetve az árnyék- és csúcsfényrészletek kiemelése
•	 Optikai objektívkorrekciók végrehajtása
•	 Két kép egymáshoz igazítása és egyesítése a mélységélesség kiterjesztéséért
•	 A legjobb módszerek alkalmazása képeink rendezésére, kezelésére és elmentésére
•	 Nagy dinamikatartományú (HDR) kép létrehozása különböző expozíciójú felvételek egyesítésével

A lecke elvégzése körülbelül másfél óráig fog tartani. Töltsük le a Lesson05 mappát a merevlemezen 
korábban létrehozott Lessons könyvtárba (vagy hozzuk létre a könyvtárat most). Munkánk során más 
néven fogjuk elmenteni a kiinduló fájlokat. Így ha szükségünk lenne az eredeti, módosítások nélküli 
leckefájlokra, bármikor újra letölthetjük őket a www.perfactkiado.hu/mellekletek oldalról.

Elindulás

Ebben a leckében több képet szerkesztünk majd a Photoshop és a hozzá tartozó Adobe Camera 
Raw alkalmazás segítségével. Különböző módszerekkel fogunk néhány digitális fényképet korrigálni, 
tetszetősebbé téve a megjelenésüket. Kezdésképpen tekintsük meg az Adobe Bridge alkalmazásban 
a fényképek „előtte” és „utána” változatait.

1 Indítsuk el a Photoshop alkalmazást, és a gyári beállítások visszaállításához eközben tartsuk le-
nyomva a Ctrl+Alt+Shift (Windows), illetve a Command+Option+Shift (Mac OS) billentyűket. 
(Lásd Alapértelmezett beállítások visszaállítása az Elindulás fejezetben.)

2 Ha a program rákérdez, a Yes gombra kattintva erősítsük meg, hogy törölni kívánjuk az Adobe 
Photoshop Settings állományt.

3 Az Adobe Bridge megnyitásához válasszuk ki a File > Browse In Bridge (Fájl > Tallózás a Bridge 
alkalmazásban) menüpontot.

4 A Bridge Favorites paneljén kattintsunk előbb a Lessons mappára, majd a Content panelen dup-
lán a Lesson05 mappára. Ezt követően kattintsunk duplán a Content panelen a Lesson05 map-
pára, megnyitva azt.

5 Ha szükséges, a bélyegképcsúszka segítségével növeljük meg kellőképpen a bélyegképek méretét. 
Ezt követően vizsgáljuk meg a 05A_Start.crw és a 05A_End.psd fájlokat.

A spanyol stílusú templom eredeti fényképe Camera Raw fájl, ezért fájlkiterjesztése nem a szoká-
sos .psd, amellyel a könyv eddigi részében találkozhattunk. Egy Canon EOS Digital Rebel fény-
képezőgéppel készült, a Canon saját .crw nyers fájlformátumában. Előbb korrigálni fogjuk ezt 
a Camera Raw képet, hogy világosabb, élesebb és tisztább legyen, majd internetre való JPEG-, il-
letve PSD-fájlként fogjuk elmenteni – ez utóbbi formátum lehetővé teszi, hogy a későbbiekben 
még dolgozzunk a képpel a Photoshopban.

 A következő képek színes változata a mellékletben látható.

PSCS6.indb   118 2012.11.05.   9:28:17



119ADOBE PHOTOSHOP CS5
Tanfolyam a könyvben

5

6	 Tanulmányozzuk a 05B_Start.psd és a 05B_End.psd bélyegképeket.

Színkorrekciót hajtunk végre, majd a Photoshopban további képjavító műveletekkel érjük el 
a végeredményt.

7	 Tanulmányozzuk a 05C_Start.psd és a 05C_End.psd bélyegképeket.

05A_Start.crw 05A_End.psd

05C_Start.crw 05C_End.psd

05B_Start.crw 05B_End.psd
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Számos javítást hajtunk végre a tengerparton álló lány portréján, így előhozzuk a képrészleteket 
az árnyékokban és a csúcsfényekben, eltávolítjuk a vörös szemet, végül pedig élesítjük a fotót.

8	 Vizsgáljuk meg a 05D_Start.psd és a 05D_End.psd fájlok bélyegképét.

Az eredeti kép torzít, az oszlopok látszólag meghajoltak. Az objektív által okozott hordótorzítást 
fogjuk eltávolítani a képről.

9	 Végül nézzük meg a 05E_Start.psd és a 05E_End.psd bélyegképeket.

Az első kép két réteggel rendelkezik. Attól függően, hogy melyik réteget tesszük láthatóvá, vagy 
az előtérben lévő pohár, vagy a háttérben lévő tengerpart látszik élesen. A mélységélesség megnö-
velésével mindkettőt élessé tesszük. Ezenkívül kerítésoszlopokat adunk a képhez, és rekeszes élet-
lenítést alkalmazunk a pohárra.

A Camera Raw fájlok
A Camera Raw, azaz nyers fájlok a digitális fényképezőgép érzékelőjéről származó nyers képadatokat 
tartalmazzák. Sok digitális fényképezőgép képes a fotókat ilyen formátumú fájlba menteni. Ezeknek 

05D_Start.crw 05D_End.psd

05E_Start.crw 05E_End.psd
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az állományoknak az az előnyük, hogy lehetővé teszik a fényképész számára, hogy a fényképezőgép 
helyett ő maga értelmezze a képadatokat, és hajtsa végre a módosításokat, illetve átalakításokat. (Ez-
zel szemben a fényképezőgép által készített JPEG-képek esetén a fényképezőgép feldolgozására va-
gyunk rászorulva.) Mivel nyers formátumban való fotózáskor a fényképezőgép semmilyen képfeldol-
gozást nem hajt végre, a Camera Raw segítségével beállíthatjuk a fehéregyensúlyt, a tónustartományt, 
a kontrasztot, a színtelítettséget és az élesítést. Ezeket a nyers fájlokat tekinthetjük a fényképek nega-
tívjainak. Amikor csak tetszik, visszatérhetünk a „negatívhoz”, és a kívánt eredmények elérése érdeké-
ben újból előhívhatjuk (feldolgozhatjuk) azt.

Nyers fájlok létrehozásához be kell állítanunk digitális fényképezőgépünket, hogy saját formátumába 
mentse a fájlokat. Amikor a fényképezőgépről letöltjük a nyers fájlokat, azoknak olyan kiterjesztésük 
lesz, mint például a .nef (Nikon gép esetén), .crw vagy .cr2 (Canon esetén). A Bridge vagy a Photo
shop alkalmazásban a támogatott digitális fényképezőgépek – a Canontól és a Kodaktól kezdve a Lei-
cán és a Nikonon át sok más gyártmányig – egész sorának nyers állományait feldolgozhatjuk, ráadá-
sul egyszerre több képet is. A saját nyers fájlokat olyan egyéb formátumokra konvertálhatjuk, mint 
a DNG, a JPEG, a TIFF vagy a PSD.

Megjegyzés: A Photoshop Raw (.raw kiterjesztés) a képek alkalmazások és számítógépes platformok közötti 
továbbítására használható fájlformátum. Ne keverjük össze a Photoshop Raw-t a nyers fájlformátumokkal.

A Camera Raw alkalmazásban nemcsak a támogatott fényképezőgépekből származó nyers fájlokat 
dolgozhatjuk fel, hanem TIFF- és JPEG-képeket is megnyithatunk, és Photoshopban nem elérhető 
szerkesztési funkciókkal dolgozhatunk. Ez utóbbi két fájlformátum azonban a fehéregyensúly és 
a többi beállítás tekintetében sem kínál olyan nagy fokú rugalmasságot, mint a nyers állományok. 
Bár a Camera Raw modul képes a nyers fájlok megnyitására és szerkesztésére, nem tudja a képet eb-
ben a formátumban elmenteni.

A 2. leckében már használtuk a Camera Raw alkalmazást: egy kép színének és világosságának szer-
kesztésére. A most előttünk álló gyakorlatokban több funkcióját is alkalmunk nyílik kipróbálni.

Fájlok feldolgozása a Camera Raw 
alkalmazásban

Ha a Camera Raw alkalmazásban korrekciót, például dőlésmentesítést vagy körülvágást hajtunk vég-
re egy képen, a Photoshop és a Bridge megőrzik az eredeti fájladatokat. Ily módon tetszés szerint 
szerkeszthetjük a képet, exportálhatjuk a szerkesztett képet, mégis érintetlenül megőrizzük az eredetit 
későbbi használatra vagy további korrekciókra.

Képek megnyitása a Camera Raw alkalmazásban

A Camera Raw a Photoshopból és a Bridge-ből egyaránt elindítható, és ugyanazokat a szerkesztési 
műveleteket egyszerre több állományra is alkalmazhatjuk. Ez utóbbi akkor különösen hasznos, ami-
kor több, azonos körülmények között fényképezett, ezért ugyanolyan megvilágítási és egyéb korrek
ciókat igénylő fotón dolgozunk.

A Camera Raw számtalan vezérlőt kínál a fehéregyensúly, az expozíció, a kontraszt, az élesség, a tó-
nusgörbék és sok egyéb jellemző módosítására. Ebben a gyakorlatban szerkesztünk egy fotót, majd 
ugyanazokat a beállításokat rendeljük a hasonló képekhez.
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10 Videók szerkesztése

Immár videofájlokat is szerkeszthetünk Photoshopban, és a képfájlok alakításához használha-
tó effektusok nagy része mozgóképek esetében is elérhető. Ez utóbbiakat létrehozhatjuk video-
fájlokból, állóképekből, intelligens objektumokból, hangfájlokból, valamint szöveges rétegek-
ből; alkalmazhatunk rájuk átmeneteket, illetve kulcskockák segítségével akár különféle hatá-
sokat is animálhatunk.
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A lecke áttekintése
Ebben a leckében a következőket fogjuk elsajátítani:
•	 Videó idővonal létrehozása Photoshopban
•	 Médiaelemek hozzáadása videocsoporthoz a Timeline panelen
•	 Mozgás hozzáadása videókhoz és állóképekhez
•	 Szöveg és hatások animálása kulcskockákkal
•	 Átmenetek beillesztése a videók közé
•	 Hang hozzáadása videofájlhoz
•	 Videó renderelése

A lecke elvégzése körülbelül másfél óráig fog tartani. Töltsük le a Lesson10 mappát a merevleme-
zen korábban létrehozott Lessons könyvtárba (vagy hozzuk létre a könyvtárat most). Munkánk  
során más néven fogjuk elmenteni a kiinduló fájlokat. Így ha szükségünk lenne az eredeti, módosí-
tások nélküli leckefájlokra, bármikor újra letölthetjük őket a www.perfactkiado.hu/mellekletek 
oldalról.

Elindulás
A leckében kamerás mobiltelefonnal felvett videókat fogunk szerkeszteni. Videó idővonalat ho-
zunk létre, videókat importálunk, átmeneteket és más videohatásokat alkalmazunk, majd renderel-
jük a kész videót. Először is tekintsük meg a projekt végleges változatát, hogy lássuk, munkánk so-
rán mit fogunk előállítani.

1	 Indítsuk el a Photoshop alkalmazást, és eközben a gyári beállítások visszaállításához tartsuk le-
nyomva a Ctrl+Alt+Shift (Windows), illetve a Command+Option+Shift (Mac OS) billentyű-
ket. (Lásd Alapértelmezett beállítások visszaállítása az Elindulás fejezetben.)

2	 Ha a program rákérdez, a Yes gombra kattintva erősítsük meg, hogy törölni kívánjuk az Adobe 
Photoshop Settings állományt.

3	 A File > Browse In Bridge (Fájl > Tallózás a Bridge alkalmazásban) menüpontot kiválasztva 
nyissuk meg az Adobe Bridge-et.

4	 Kattintsunk a Bridge ablak bal oldalán található Favorites (Kedvencek) fülre. Jelöljük ki a Les-
sons mappát, majd kattintsunk duplán a Content (Tartalom) panelen a Lesson10 mappára.

5	 Kattintsunk duplán a 10End.mp4 fájlra, hogy megnyissuk a QuickTime (vagy más videoleját-
szó) alkalmazásban.

6	 A videó végleges változatának lejátszásához kattintsunk a videolejátszó lejátszás gombjára.

A rövid videót egy tengerparti napon készített felvételekből állították össze. Átmeneteket, ré-
teghatásokat, animált szöveget és zenét tartalmaz.
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7	 Zárjuk be a QuickTime alkalmazást, és térjünk vissza a Bridge-be.

8	 Dupla kattintással nyissuk meg Photoshopban a 10End.psd fájlt.

A Photoshopban megjelenik a Timeline (Idővonal) panel, a dokumentumablakban pedig segéd-
vonalakat is láthatunk. Ezek a segédvonalak jelzik azt a területet, amely a videó lejátszása esetén 
látható lesz. A Timeline panel az összes videofelvételt, illetve a hangsávot is tartalmazza.

9	 Ha befejeztük a kész állomány böngészését, zárjuk be.

Új videoprojekt létrehozása
A videókkal végzett munka valamelyest eltér attól, ahogy az állóképeken dolgozunk a Photoshopban. 
Mint látni fogjuk, érdemes először a projektet létrehozni, majd importálni a felhasználni kívánt mé-
diaelemeket. A most következő gyakorlatban kiválasztunk a projekthez egy videokészletet, majd ki-
lenc video- és képfájlt adunk hozzá, s elkészítjük ezekből a mozgóképünket.

Új fájl létrehozása

A Photoshop CS6 számos film- és videokészletet tartalmaz, amelyekből céljainknak megfelelően  
választhatunk. A következőkben létrehozunk egy új állományt, és kiválasztjuk a számunkra szükséges 
készletet.

1	 Válasszuk ki a File > New (Fájl > Új) menüpontot.

2	 Adjuk az állománynak a 10Start.psd nevet.

3	 Válasszuk ki a Preset (Készlet) menüből a Film & Video (Film és video) készletet.

4	 A Size (Méret) menüben kattintsunk a HDV/HDTV 720p/29.97 elemre.

Megjegyzés: A leckében használt videót Apple iPhone-nal vették fel, ezért a HDV készletek megfelelő válasz-
tásnak tűnnek. A 720P készlet túl nagy méret nélkül biztosítja a megfelelő minőséget, így online lejátszásra is 
alkalmassá teszi majdani művünket.
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5	 A többi beállításnál maradjunk az alapértelmezett értékeknél, és kattintsunk az OK gombra.

6	 Válasszuk ki a File > Save As (Fájl > Mentés másként) menüpontot, és mentsük el a fájlt a Les-
son10 mappába.

Médiaelemek importálása

A Photoshop CS6 kifejezetten a videókkal való munkavégzésre alkalmas eszközöket is tartalmaz, ezek 
egyike a Timeline panel. Elképzelhető, hogy a panel már meg van nyitva alkalmazásunkban, mert az 
imént megtekintettük a leckefájl végleges változatát. A Timeline panelt a videók rétegekbe rendezésé-
re, tulajdonságaik animálására, az egyes rétegek kezdő- és végpontjának beállítására, illetve átmenetek 
hozzáadására használhatjuk. Annak érdekében, hogy a megfelelő eszközök, valamint vezérlők mind 
rendelkezésünkre álljanak, a videóban felhasználandó állományok importálása előtt kiválasztjuk 
a Motion (Mozgókép) munkaterületet, és elrendezzük a paneleket.

1	 Először is válasszuk ki a Window > Workspace > Motion (Ablak > Munkaterület > Mozgókép) 
menüpontot.

2	 Ezt követően húzzuk fel a Timeline panel felső szélét annyira, hogy a munkaterület alsó felét 
a panel foglalja el.

3	 Válasszuk ki a Nagyító eszközt ( ), majd kattintsunk az eszközbeállítások sor Fit Screen (Képer-
nyőhöz igazítás) gombjára. Ekkor a képernyő felső részén a teljes rajzvásznat láthatjuk.

4	 Kattintsunk a Create Video Timeline (Videó idővonal létrehozása) gombra. A Photoshop új  
videó idővonalat hoz létre, amely két alapértelmezett sávból áll: ezek a Layer 0 (Réteg 0) és  
az Audio Track (Hangsáv).
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5	 Kattintsunk a Layer 0 sávon a Video menüre, és válasszuk ki az Add Media (Média hozzáadása) 
menüpontot.

6	 Menjünk a Lesson10 mappába.

7	 A Shift billentyű lenyomva tartása mellett jelöljük ki az 1-től 9-ig számozott videókat és fényké-
peket, majd kattintsunk az Open (Megnyitás) gombra.

Megjegyzés: Ha úgy használjuk az Add Media gombot, hogy előtte nem határoztuk meg a rajzvászon mé-
retét, a Photoshop az általa elsőnek megtalált videofájl mérete alapján határozza meg a projekt méretét. 
Amennyiben kizárólag képeket importálunk, akkor a képméret alapján teszi ugyanezt.

A Photoshop az általunk kijelölt mind a kilenc médiaelemet ugyanarra a sávra importálja, amely-
nek most már Video Group 1 (Videocsoport 1) a neve a Timeline panelen. Az állóképeket lila, 
a videofelvételeket kék háttérrel jeleníti meg a panel. A Layers (Rétegek) panelen a médiaelemek 
külön rétegekként jelennek meg a Video Group 1 nevű rétegcsoporton belül. A Layer 0 nevű ré-
tegre nincs szükségünk, ezért kitöröljük.
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8	 Jelöljük ki a Layers panelen a Layer 0 réteget, és kattintsunk a panel alján lévő Delete Layer (Ré-
teg törlése) gombra. Ha a Photoshop törlési szándékunk megerősítését kéri, kattintsunk a Yes, 
azaz Igen gombra.

A felvételek hosszának módosítása az idővonalon

Az idővonalon elhelyezett felvételek (álló- és mozgóképek) egymástól eltérő hosszúságúak, ami azt je-
lenti, hogy különböző hosszan fognak lejátszani. A most készítendő videóban azt szeretnénk, hogy az 
azt alkotó felvételek ugyanolyan hosszúak legyenek, így mindegyiket lerövidítjük 3 másodpercesre. 
A felvétel hosszát (lejátszásának időtartamát) másodpercekben és képkockákban mérjük: a 03:00 
pontosan 3 másodpercnek, a 02:25 pedig 2 másodperc és 25 képkockának felel meg.

1	 Húzzuk a Timeline panel alján lévő Control Timeline Magnification (Idővonal nagyításának állí-
tása) csúszkát jobbra, hogy megnöveljük az idővonal nézetének nagyítását. Célszerű akkorára na-
gyítani, hogy lássuk az egyes felvételek bélyegképét, illetve elegendő részletet az idővonalzóban 
ahhoz, hogy pontosan tudjuk módosítani az egyes felvételek időtartamát.

Megjegyzés: Jelen esetben minden felvételt ugyanolyan hosszúságúra rövidítünk le, ám saját projektjeinket 
természetesen különböző hosszúságú felvételekből is összeállíthatjuk.

2	 Húzzuk az első felvétel (1_Family) jobb szélét jobbra, az idővonalzó 03:00 pontjáig. Húzás köz-
ben a Photoshop megjeleníti a végpontot és az időtartamot is, így könnyen megtaláljuk a megfe-
lelő pontot, ameddig húznunk kell az egérrel.

3	 Húzzuk a második felvétel (2_BoatRide) jobb szélét addig, amíg ennek a felvételnek is 03:00 
nem lesz az időtartama.

Ha videofelvételt rövidítünk le, azzal nem sűrítjük össze a tartalmát, hanem a felvétel egy részét 
eltávolítjuk a videóból. Jelen esetben minden egyes felvételnek az első három másodpercét szeret-
nénk felhasználni. Ha a videofelvételek más részét szeretnénk megőrizni, mindkét vége felől le 
kellene rövidíteni azt.

4	 Ismételjük meg a 3. lépést az összes többi felvétellel is annak érdekében, hogy mindegyik  
3 másodperc hosszú legyen.
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